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Foreword

iX Developer User’s Guide

Foreword

The iX Developer software is used to configure iX Panels and PC operated control
applications, including applications for IPCs (Industrial PCs).

iX Developer makes it easy to create logical, flexible and effective HMI
applications that provide the right information on the right occasion to operators
and to other systems.

This manual is based on an example project that describes a step-by-step design
ofa project for iX Developer.

For more detailed information, please refer to the iX Developer help file.
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Introduction

1 Introduction

The iX Developer software is used to configure iX Panels and PC operated control
applications, including applications for IPCs (Industrial PCs) from Beijer
Electronics.

iX Developer contains all basic functions needed in an application. The functions
are tested and developed with customer needs and preferences in focus.

Pre-defined objects in iX Developer can be used to create complete process
images, providing an overview of a complex application. You can customize the
pre-defined objects or create objects of your own.

Communication drivers for alarge number of controllers and automation
equipmentare available.

1.1 Controller

Operator panels can be connected to many types of automation equipment, such
as PLCs, servos, and drives. Further on, the expression controller is used as a general
term for the connected equipment.

1.1.1 Tags

Datavalues in a controller are referred to as zags. Tags may also belong to the
system or be internal. A taghasa symbolic name and can be of different data types.

Objects connected to tags can change values in the controller, and tag values can be
reflected by changing object appearance in various ways. Objects in a screen will
remain static until connected to a tag.

1.2 Manual Structure

The USERS GUIDE is based on an example project that makes it easier to start
using iX Developer. If the instructions in the example are followed carefully, this
should result in a functional project that can be further developed, or used for
inspiration. The target of the example isa PC, but all functions works similarly for
all supported operator panels.

Detailed information about iX Developer is available in the help file, displayed by
pressing F1 while using the software.

The instructions in the USERS GUIDE are more detailed in the beginning. Asthe
example progresses and you become familiar with iX Developer, instructions for
tasks thatare of a repetitive nature may be brief or omitted.

BeijerElectronics, MAEN832F 6



Installation and Start

2 Installation and Start

iX Developer is installed on a DEV PC, where projects are developed, designed
and compiled. The projectis then run inan OPERATOR PANEL, PC or PC
TARGET to observe and control a controller (or a group of controllers).

2.1 SystemRequirements

2.1.1 iIXDeveloper

Parameter Recommendation
RAM 2GB
Processor 2GHzor higher

Operating Microsoft Windows 7
system

Microsoft Windows Vista

Microsoft Windows XP SP3

Graphics Tier2:
card

DirectX version Must be greater than or equal to
9.0.

Video RAM

Pixel shader Version level must be greater
thanorequal to2.0.

Vertex shader Version level must be greater
thanorequal to2.0.

Multitexture units Number of units must be greater
thanorequal to4.

Updates

Software, drivers and protocols may have been updated since the USB stick was
produced. Therefore, itis recommended that you use the built-in update function
in iX Developer before creating a project.

Therefore, itis recommended that the built-in update function in iX Developer is
used before creating a project

2.1.2 IXRuntime

Parameter Recommendation
RAM 1GB
Processor 1.3GHzor higher

BeijerElectronics, MAEN832F 7



Installation and Start

DirectX version

Parameter Recommendation
Operating Microsoft Windows 7
system
Microsoft Windows Vista
Microsoft Windows XP SP3
Graphics Tier 2:
card

Must be greater than or equal to
9.0.

Video RAM Must be greater than or equal to
120 MB.

Pixel shader Version level must be greater
thanorequal to2.0.

Vertex shader Version level must be greater

thanorequal to2.0.

Multitexture units

Number of units must be greater
thanorequal to4.
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Installation and Start

2.1.3 Special Requirements for Some
Objects

For some objects to be included in the iX Developer project, specific software
versions are required. Simulation of the project on the DEV PC may also be
limited for some targets.

Object Minimum Simulation on Simulation on
requirement PC target panel target
MediaPlayer Windows MediaPlayer | Supported Not supported
10
PDF Viewer AcrobatReader9 Supported Not supported
Web Browser InternetExplorer7 Supported Not supported

2.1.4 Starting iXDeveloper

The installation creates an icon for the configuration tool in the group named iX
Developer in Windows Start menu.

Click on Start/All Programs/ iX Developer/ iX Developer to start the

configuration tool.

2.1.5 Help

Help topics are provided when pressing F1 while iX Developer is running.

BeijerElectronics, MAEN832F 9



New Project

3 New Project

Objective:

e  Creatinganew project.
e Getting familiar with the tool windows and the layout of the desktop area.

3.1 CreatingaNewProject

1. StartiX Developer and select Create New Project.
This starts awizard that will guide you through creating the project.

2. Choosea PCwitha 1024 x 768 resolution as target for the application. Click
Next.

3. Select DEMO in the list of controllers. Click Next.

The demo controller, including regular tags (data containers) and counters, is
used to design and test a project directly on the DEV PC without connection
to an external controller.

4. Give the project a name. For this tutorial use DEMO_TEST. Check that
the suggested location is appropriate. If not, click Browse to selectanother
location.

5. Click Finish.

Project files can be stored anywhere in the computer environment where you have
write access rights.

The project opens automatically.

BeijerElectronics, MAEN832F
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New Project

3.2 DesktopArea

The desktop area displays screens and configuration pages for project components
such as controllers and functions. The desktop area shows only one screen or
component ata time. When multiple screens or components are opened a row of
tabs are shown in the upper part of the desktop area. Clickingon a tab activates

its contents for editing.

If there are more tabs open than can be displayed, navigation arrows in the upper
partof the desktop area can be used to scroll between them.

o= r 2.10 - MyTestProject Properties
: Home Project System Insert View Dynamics General Actions
(e Qo
E [ Delete Screen K|\ = g 8 (o] = A E} S ZhShape Fill - Select Tag.. =
Background... - = _ | B . L7 Shape Outline = || Sefect Security Groups... - —
Clipboard Y 299 potauit - || &b A& | font | Amange SQt."!ﬁ. Qe ) shape Effects~ || D= Narne
| | 2
Project Explorer I x Screenl x R
: f
Q@ Aliscreens <
n - —— z
® \J ahoma A LA T4 B
T Select Tag... - =]
Select Security Gro @Lu t v i—
om— adl \ame: CircularMeterl é“
- =
Cirl+C g’
3
=]
Hide Selection é—
Lock Selection
i i Save Variation
(42 Search Q) e
- Order
= Group
Q I o Make Same Size
Align
@ Multiple Languages Create Series
t% Security : i Properties
= o s e e e )
‘{J °% Layout| Xaml Script Aliases Tags used: 0/4000
(3] Error List
Indicationin
picture Desktop areacomponent Described in section
A ProjectExplorer Project Explorer
B Ribbon tabs Ribbon Groups and Controls
C Control groups
D Controls
E Quick Access Toolbar Quick Access Toolbar
F MiniToolBar MiniToolBar and ContextMenu
G ContextMenu
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New Project

3.2.1 ProjectExplorer

When a new project is opened, an empty screen is active in the desktop area. The
Project Explorer is docked to the left.

3.2.2 Ribbon Groups and Controls

Ribbon tabs are located in the top section of the tool window. Each ribbon tab
holds one or several control groups. Each group containsaset of related controls.
You use the controls to design screens, and to make settings for objects and
controls in the project.

If you are not used to software with ribbon tabs, please spend a minute to get
familiar with the ribbon concept.

3.2.3 Quick Access Toolbar

The Quick Access toolbar is always visible at the top of the desktop area. It
contains the commands Save, Undo, Redo, Run and Simulate as iX Developer is
started.

3.2.4 MiniToolBar and ContextMenu

When right-clicking objects in iX Developer, a MiniToolBar and a ContextMenu
are displayed. The MiniToolBar contains commands that are specific for iX
Developer, to for example connect objects to controller tags. The ContextMenu
contains regular Microsoft application commands such as Copy, Paste etc.

BeijerElectronics, MAEN832F 12
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4 Controller Tags

Objective:

* Definingataglist for the project.
e Savingthe project.

4.1 Adding Tags

Objects connected to tags can change values in the controller, and tag values can be
reflected by changing object appearance in various ways. Objects in a screen will
remain static until connected to a tag.

1. Click on Tags in the Project Explorer.

The tags configuration page opens on the desktop. There is one elements in

the tags list by default.
2. Click on the first field (Name) in the first row.

A highlighted row is added and the text Tag1 appears.
3. Press [TAB] on the keyboard.

The selection moves to next field (Data Type for Tags). You do notneed to
change the data type.

Note:

The data type for the tag can be used as a presentation format in some situations; for
example to show the correct engineering unit when using scaling. DEFAULT follows
selection made for the Controller data type.

4. Press [TAB] on the keyboard again.

The selection moves to next field (Access Right). You do not need to change
the access rights now.

5. Press [TAB] on the keyboard again.
The selection moves to next field (Controller Data Type). You do not need
to change the data type now.

6. Press [TAB] on the keyboard again.
The selection moves to next field (Controller 1).

7. Type “D0” in the Controller 1 field.

The entries in the Controllers column correspond to tags in the selected
controller. There are predefined tags in the DEMO controller that can be
accessed by their respective tag address, e.g. D0 denotes an integer tag field.

8. Press[TAB] until the two first rows are completely filled in. Type “D1” for the

second controller tag.

Some fields are automatically filled and when needed, incremented. The data
type is automatically changed depending on what you type in the Controllers
column.

The Name of a tag is an identifier for the tag and can be any alphanumeric
string, beginning with aletter (a-z, A-Z).

BeijerElectronics, MAEN832F 13



Controller Tags

9. Rename Tagl to “MeterAndSlider”.

W screent <7 Toos < I

J Tags || Controllers || Triggers || Poll Groups " Index Registers ]
Home |
Columns Visible
‘ Add - ‘ Delete [ Scaling [[7] Others
[] Data Exchange
[ Tag Controllers
Mame Data Type Access Right | Data Type Controller 1
¥ | MeterAndSlider DEFALLT ReadWrite INT15 D[I :
Tag2 DEFALLT Readirite INT16 D1

The DO tag will be used in the next section to control and observe a controller tag
value in a screen.

4.2 SavingtheProject

1. Click on the Save symbol in the Quick Access Toolbar.
The project will be saved in the location that you selected when creating the
project.
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5 Editing Objects

Objective:

* Insertingasliderand ameter.

e Learninghow toformatandalign objects.

e  Testingthe project; controlling and observing a controller tag value with objects
inascreen.

5.1 AddingObjects
5.1.1 Meter

1. Clickon the Screen] tab in the desktop area and make sure that the Home tab
in the ribbon area is selected. Selecta circular meter from the Objects group.
Place it somewhere in the upper left section of the screen.

2. Dragacorner handle to resize the meter to a suitable size where the meter
needle and the scale are clearly visible.
3. Right-click on the meter. Click on Select Tag... in the MiniToolBar. Select

the MeterAndSlider tag by clicking on it in the drop-down menu, and then
click OK.

5.1.2 Slider

1. Selectaslider from the Objects group. You may need to expand the Objects
group by clicking the small arrow at the lower right in order to select the slider.
Place it just below the circular meter on the screen.

2. Right-click on theslider. Click on Select Tag... in the MiniToolBar. Select

the MeterAndSlider tag by clicking on itin the drop-down menu, and then
click OK.

10 20 30 4 50 60 70 80 S0 100

I T
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Editing Objects

5.1.3 Align

An object that is dragged snaps into position relative to other objects.
1. Slowly drag the slider up and down.

Notice that the slider snaps into position at a short distance below the meter.
2. Slowly drag the slider to the leftand to the right.

Notice that the slider snaps into position and that snap lines appear when the
slider is aligned with the meter.

3. Arrange theslider in a position closely below the meter and with its left edge
aligned with the left edge of the meter.

5.1.4 Resize

1. Makea multiple selection of the two objects (pointatan empty area in the
screen and drag diagonally across the objects).

A multiple selection (group) has one primary object. The primary object has
an orange frame; the other objects have blue frames. When enforcing format
commands on the group the primary object is used as a template.

If the meter is not the primary object then:
2. Click onitto change the primary selection of the group to the meter.
Now adjust the width of the objects in the group:

3. Click on the Arrange control, located in the Format group of the Home tab,
and select Make Same Width.

5.1.5 Changing Appearance

Select the slider on Screenl.

2. Click on the Quick Styles control in the Format group and select a new color
style.

3. Click the small arrow at the lower right of the Format group in order to make
additional settings for outline, shadow/fill effects etc.

4. Select the meter on Screenl.

5. Select the General ribbon tab and locate the Style group. Try the different

pre-defined styles and evaluate which style suits your preferences the best.

5.2 RunningProject Test

The project can be compiled and run atalmost any time. This allows you to test
your design continuously in an iterative manner.

1. Click on the Runicon in the Quick Access Toolbar.

The project is now validated, and when no errors are found, the project will be
compiled and executes in the development environment.

2. Dragtheslider handle back and forth.

Since both objects are connected to the same tag, the meter needle follows as
you change the value of the slider control.

3. Close the Run window.

BeijerElectronics, MAEN832F 16
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6 Navigation and Screen Jumps

An iX Developer project consists of screens with objects, usually connected to
controller tags. All screens have the same basic functions. A screen can be given
specific properties to specialize its behavior in the project:

+  Startup Screen: The Startup Screen is the first screen that is displayed in
runtime. By default, Screenl is used as Startup Screen, butany screen can be
designated Startup Screen by right-clicking on the screen and selecting Set as
Startup Screen.

»  Background Screen: Any screen, except screens with Aliases, can be used asa
Background Screen by the other screens in the project. For more information
about Aliases, please refer to the iX Developer help file.

*  Screen Template: A screen that is saved asa Screen Template can be used not
only in the current iX Developer project, but also in all future projects.

Screen jumps are made with actions that can be assigned to e.g. buttons. When
using the Navigation Manager to add screens and create links between screens,
buttons are added automatically in the upper left corner of the screen that the link
originates from.

Objective:

e  Addingnew screens and setting up screen jumps with buttons.

6.1 ScreenNavigation

6.1.1 Navigation Manager

+  Clickon the View tab in the ribbon area. Click on Navigation Manager.
The Navigation Manager opens in the desktop.

6.1.2 AddingaScreen

» DPointatScreenl. Clickand draga connection from Screen1 to anywhere in
the Navigation Manager area.

A new screen appears (Screen2). A button labeled Screen2 appears in the
upper left corner of Screen1.

BeijerElectronics, MAEN832F 17
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6.1.3 Screen Jump

+ Clickand draga connection from Screen2 to Screen1 in the Navigation
Manager.

Abutton labeled Screen1 appears in the upper left corner of Screen2.

Mavigation Manager - X

m

6.2 BackgroundScreen
6.2.1 AddingaScreen

e C(Click on Screen on the Insert ribbon tab.

A new screen (Screen3) is created in the project, and opens for editing.

6.2.2 Background Screen

Make sure that Screen3 is open for editing on the desktop.

2. SelectaButton from the Objects group (located on the Home tab), and place
itin the lower left area of Screen3. Label the button “Start Screen”.

BeijerElectronics, MAEN832F 18



Navigation and Screen Jumps ‘

3. Keep the button selected and click on the Actions tab. Select Show Start
Screen, located in the Screen group, from the drop-down list for the Click
action.

= None

Y None
Selects no action.

=l Screen

Close Screen
Closes the current screen.

Print Screen
Frints the current screen on printer or to file.

E@ Show Next Screen
Returns next screen
E@ Show Previous Screen

Returns to previous screen.

Show Screen
Navigates to the specified screen,

Show 5tart Screen
Mavigates to start screen.

+ Address Book
+ Alarm Distributor Server
+ Audit Trail

+ Chart

+ Data Logger

+ Database

+ Qutput Devices
+ Recipe

+ Reporting

+ Security

+ Tag

+ Trend Viewer

+ Other

4. Open Screen?2 for editing by clicking on it in the Project Explorer.

5. Select the Home tab. Select Screen3 in the Background Screen drop-down list
in the Screen group.

6. Try to change location of the Start Screen button in Screen2. This is not
possible. Notice that changes made to Screen3 are reflected in Screen2.

There are now two navigation facilities from Screen2 to Screen1 (the Start Screen).

BeijerElectronics, MAEN832F 19
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6.3 RunningScreen Navigation Test

Run the project.
2. Verify that each of the buttons in Screen2 performs a jump to Screenl.

Since no screen has been set to be Startup Screen, Screen1 remains Startup
Screen for this project.

3. Close the Run window.

BeijerElectronics, MAEN832F 20
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7 Trend Viewer

The trend viewer function stores register information from the controller in
the operator panel. Real-time trend viewer as well as historical trend viewer is
available.

Objective:

e Addingatrendviewerobject with two curves.

7.1 AddingaReal-Time Trend Viewer

1. Open Screenl for editing in the desktop.

2. Select the Trend Viewer object from the Objects group and place it on the
screen.

7.1.1 Curves

1. Click on Tags in the Project Explorer and add a tag. Type “Counter” in the
Name field and connect it to CO in Controllerl.

CO0 isa counter that counts from 0 to 100 and back to 0 with a frequency of 1
Hz.

2. Open Screenl, make sure that the trend viewer object is selected, and click
Edit Curves on the General tab.

3. Addacurveand connect it to the same tag that you used for the slider in
Screenl.

4. Addasecond curve and connectit to the Counter tag you just added, and
selectanother color for this curve.

Home Project System Insert View Dynamics General Actions

| B2
B | @ | Min Value 0 Major Ticks 11 Time Range | 00:04:00 :Iél. Black - || ] scale
Max Value 100 Minor Ticks 4 j 3 - | ¥l Grid
Edit Trend Moger Ticks
Curves || Dynamics
Name Tag Log Item Expression Color Thickness Minimum Value ... | Maximum Value ...
3 lCurve 1 Meterandsider | B 2
Curve 2 Counter . 34; 177, 76 2
5. Click OK.
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Trend Viewer

7.2 RunningReal-Time Trend Viewer
Test

*  Runthe projectand check that both curves are visible in the trend viewer. Test
that Curve 1 changes with the slider.

7.3 TrendViewer History
7.3.1 Actions

1. Open Screenl for editing in the desktop.

2. Placeabutton to the left of the trend viewer object. Label the button “Trend
Viewer History”.

3. Keep the button selected and click on the Actions tab. Select Trend Viewer

History, located in the Trend Viewer group, from the drop-down list for the
Click action. Select TrendViewerl from the Select Trend Viewer drop-down
list, and On-mode.

4. Select the trend viewer object and click on the Actions tab. Select Trend
Viewer History for the MouseDown action. Select TrendViewer1 from the
Select Trend Viewer drop-down list, and Off-mode.

7.4 RunningHistorical Trend Viewer
Test

1. Run the project.

0 10 20 30 40 50 60 70 80 90 100

FeH

Trend Viewer History

2. Testthatyou can switch to the historical trend viewer with the Trend Viewer
History button.

3. Goback to real-time trend viewer by clicking on the trend viewer object.
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8 Alarm Management

Alarms are used to make the operator aware of events that require immediate
action. Analarm is set when a certain condition is met. Analarm condition is
designed as alogical evaluation of a tag value. Alarms can be divided into groups
to create an order of priority.

Objective:

e  Configuringthe alarm listand designing an alarm object.

8.1 AlarmIndicator

When an alarm goes active, the Alarm Indicator becomes visible to alert the
operator, regardless of which screen is active.

The appearance of the alarm indicator depends on the current alarm status.
Select General settings in alarm server properties page to decide for which alarm
statuses to show the alarm indicator.

The Alarm Indicator will show the most severe alarm in the alarm list with the
following indications:

Flashing red when there is any active, unacknowledged alarm.

+  Flashing green when no active alarms exist, but inactive unacknowledged

alarms exist.
Flashing green when there are only active acknowledged alarms.

The Alarm Indicator disappears when all alarms are both acknowledged and have
returned to inactive status.

BeijerElectronics, MAEN832F
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8.2 AlarmServer

+ Click on Alarm Server in the Project Explorer to open the Alarm Server
configuration page.

8.2.1 Alarm Groups

The Alarm Groups tab is used to set up multiple alarm groups, e.g. when a project
needs separate management of alarms for independent functions. In this example,
the defaultalarm group is used.

8.2.2 Alarm Items

Select the Alarm Items tab. Add alarms based on tags in the controller tag list.

2. Defineadigital tag (named BoolAlarmTag) directly in the alarm list by
clicking Add in the tag selection list.

This tag will be internal unless connected to a controller on the Tags
configuration page, and using an internal tag works just fine for this example
project. See chapter Internal Tags for information.

8

| Alarm Items || Alarm Groups |

J Home |
[ H . _ ||
| Add -;l Delete Settings... Show Selection... vi | Import.. ~
| Default |
Mame & Text Tag Expres... Condition Trigger Value History Adknowleda. .. Remot... Action
AlarmItemd  Slider max value MeterAndSlider GreaterThan 93 = v
AlarmIteml  Boolean tag BoolAlarmTag EqualTo 1 & v
AlarmItem2  Counter 10 Counter EqualTo 10 153 v
» |AlarmItem3  Counter 20 =-- | Counter - --- EqualTo - 20 v ¥ -

3. Leave the columns for Acknowledge Required and History checked. Leave
the other fields empty.

4. Make sure thatall alarm tags can be controlled from the project screens or
that they will be triggered by other mechanisms (the counter will trigger
AlarmlItem2 and AlarmItem3 after 10 and 20 seconds respectively).

5. Placeabutton to the left of the trend viewer object. Label the button “Set
Alarm”.

6. Keep thebutton selected. On the Actions tab, select Toggle Tag, located in
the Controller group, from the drop-down list for the Click action. Select
BoolAlarmTag in the Select Tag field.
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8.3 AlarmViewer

1. Open Screen? for editing in the desktop.
2. Select the AlarmViewer from the Objects group and place it in the screen.
The columns and button placement can be customized in an alarm object.

3. Select the alarm object on the screen, and click on the General tab. In the
Buttons group, click on Position and select to place the buttons against the

Top border.
4. Adjust thesize so thatall button controls in the alarm object are visible.

5. Use Show Columns in the Settings group to customize the alarm information
and the order of the columns in the Alarm Viewer.

8.4 RunningAlarm Test

1. Run the project.
2. Testto trigger the alarms.

Ack Selected [ Ack All \ [ Clear \ l Filter ‘ l Info ‘ l Il ‘

Name State Text Active Time Normal Time Inactive Time Acknowledged Time
AlarmItem2  Normal Counter 10 2010-11-02 15:22:46 2010-11-02 15:22:51 2010-11-02 15:22:47 2010-11-02 15:22:51
AlarmItem3  Inactive Counter 20 2010-11-02 15:22:01 2010-11-02 15:22:02
AlarmIteml Inactive Boolean tag 2010-11-02 15:18:53 2010-11-02 15:19:43

Active: 1 Inactive: 2 Ack: 1 Normal: 1 [5/5]

3. Pressthe Ack All button and observe the Alarm Indicator.

4. Make sure thatall alarm tags are inactive. Press the Ack All button to
acknowledge all alarms.

5. Press Clear to remove all alarms of normal status (acknowledged and inactive).
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9 Recipes

Recipes are used to set or save a predefined group of tags in one operation.

Objective:

*  Creatingand using recipes to change multiple values.

9.1 CreatingRecipe Tags

»  Createagroup of controller tags that the recipe should affect. Use three integer
values to set weight, length and width of an imaginary item.

o

Tag
MName Data Type
MeterAndSlider DEFALLT
Tag2 DEFALLT
Counter DEFALLT
BoolAlarmTag DEFAULT
Weight DEFALLT
Length DEFALLT
I | Width DEFALLT
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Access Right
FeadWrite
ReadWrite
FeadWrite
ReadWrite
FeadWrite
FeadWrite
ReadWrite

Contrallers

Data Type Controller 1

INT16 Do

INT15 b1

INT1G Co

DEFALLT

INT16 D2

INT16 D3

— [14 .............................
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9.1.1 AddingaScreen

1. Open the Navigation Manager. Point to Screen1 and drag a connection toan
empty spot in the screen navigation area.

Mavigation Manager - X

m

A new screen (Screen4) is created in the project.

2. Open Screen4 and select the Home tab. In the Screen group, select Screen3 in
the Background Screen drop-down list.

This enables navigation from Screen4 to Screenl.

9.1.2 Adjusting Navigation Buttons

»  OpenScreenl. Select the button labeled Screen4 (in the upper left corner)
and move it so the button placed under it (Screen2) becomes fully visible.
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9.2 NewObjects

Open Screen4 for editing in the desktop, and add aslider.

2. Right-click on the slider and point to Select Tag... to open the controller
drop-down list in the MiniToolBar. Select Weight.

This connects the Weight tag to the objectand the list closes.

3. Press Ctrl, then drag the slider across the screen to make a copy of it. Position
the new slider and connect it to Length. Repeat for the Width tag.

9.2.1 Show Info

Itis possible to show information about which tag each object is connected to, and
if dynamics or actions are configured for the object, by clicking on the Show/Hide
Info button in the desktop area, or by using the keyboard shortcut Ctrl + D.

»  Press Ctrl + D on the keyboard to check that the tags are correctly bound to
the sliders in the screen.

Waight

9.3 Recipeltems

1. Click on Recipe on the Insert tab to add a new recipe.

The recipe configuration page opens in the desktop. The new recipe is also
available from the Project Explorer.

2. Enteragroup of tags to set in the recipe on the Tag Configuration tab.

=

MName Tag

Recpelteml Weight

Redpeltem2 Length
1 Recipeltem3 - Width
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9.4 SavingaRecipe

1. Open Screen4 for editing in the desktop and place a button next to the set of
sliders for the recipe tags. Label the button “Save Recipe”.

2. Click on the Actions tab and select Save Recipe, located in the Recipe group,
from the drop-down list for the Click action. Make sure that Recipel is
selected.

3. Leave Recipe dataempty.

9.5 LoadingaRecipe

1. Open Screen4 for editing in the desktop, make a copy of the Save Recipe
button.

2. Change thelabel to “Load Recipe”, and to load Recipel by selecting it for the
Click action Load Recipe.

3. Leave Recipe dataempty.

9.6 RecipeData

Create a predefined recipe by defining values on the Runtime Data tab of the
recipe configuration page.

1. Open the recipe configuration page by clicking on Recipel in the Project
Explorer.

2. Click on the Runtime Data tab. Enter tag values to setin a recipe. Entera
name (Runtime Recipe Title) for the recipe.

Runtime Recipe Tite Redpelteml Redpelternz Recpeltem3
Book 2 25 15

ITv 30 45! &0}

3. Open Screen4 for editing. Place a new button next to the set of sliders. Label
the button “Load Book”.

4. Select Load Recipe in the Click drop-down list.
5. Select Recipel, and select Book for recipe data.

9.7 RunningRecipe Test

1. Run the project.
2. Testtoset thessliders to various values and save the values in recipes.
3. Testtoload the recipes.

Check that the sliders change according to the recipe values.
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10 Dynamics

Dynamic object properties are used to move and resize objects based on controller
tag values.

Objective:

e Changingsize and color of an object based on tag value changes.

10.1 CreatinganObject

*  Open Screen4 for editing. Select the Rectangle in the Objects group of the
Home tab and place a small square below the set of sliders for the recipe tags.

0 10 20 30 40 50 60 YO0 80 90 100

Save Redpe

Load Redps

Load Book

BeijerElectronics, MAEN832F

30



Dynamics

10.2 Resizingan Object

1. Select the square. Click on Size on the Dynamics tab. Select the Width tag for
Width and the Length tag for Height.

2. Adjust the enlarged size of the square directly on the screen and note the
change of values in the Resize Dynamics Editor window.

3. Setthe fields for Tag Start Value to the start size values of the square (Start
Width, Start Height). Set both fields for Tag End Value to “100”.

Edit Size Dynamics

Clear Dynamics

BeijerElectronics, MAEN832F
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10.3 Coloringan Object

1.

Select the square. Click on Fill in the Color group of the Dynamics tab.
Assign the Weight tag in the Select Tag drop-down list.

Adjust the tag values to change the color of the square depending on
the Weight tag value. The example in the picture below uses fill color in
combination with a gradient.

Project u}rstem

mE Rl 9 3.0n)

Move  Size Fill  Outline || Visibility Blink Generdlq

Coloi

Start End
- 0 10
11 30
51 90
Lk 100

10.4 Running Dynamics Test

1.

Run the project.

2. Testto change the tag values with the sliders and by loading recipes. Observe

BeijerElectronics, MAEN832F

what happens with the size and color of the small square.
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11 Script

Scripts are used to manage functionality for objects. Scripts are written in C#.

Objective:

* Insertingabutton and text box.
*  Writing ascript for the button to affect the text in the text box.

11.1 AddingObjects

1. Open Screen2 for editing and add a TextBox from the Objects group (located
under Windows Controls) to the screen.

2. Place abutton on the screen and label it “Write Test”.
11.2 ScriptTab

1. Select the Write Test button.

2. Click on the Script tab located in the lower left the desktop area. Thiswill
change from Layout view mode to Script view mode.

3. Click on the Button2 node.

Screenl % Screen? X |

- MlamViewer1

- Button 1

- Button2

-ﬁe Down

- MouseEnter

- Mouszeleave
i MouseUp

- Screen

- TextBox1

w[F] [

¥

4. Double-click on the Click node to start typing script code for the Click event
for Button2.

A context sensitive name completion feature (IntelliSense) can be activated
during typing with Ctrl + [Spacebar] and it triggers automatically when a
period (*.’) is typed after a code element.

BeijerElectronics, MAEN832F
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5. Type the following as the click event code:

TextBoxl.Text= "Test":;

C# code on the Script tab:

public partial class Screenl
{

void ButtonZ Click(System.Object sender, System.Eventirgs e)
{

TextBoxl.Text= "Test";

11.3 Running Script

1. Run the project.

2. Click on the Write Test button and check that the text string assigned with the
script code now appears in the text box.
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12 Internal Tags

Internal tags can be used to calculate values that need not be represented in the
controller, for example information only for the operator.

Objective:

e  Writingascript to perform acalculation of the area using the length and width
tags.
e  Showingtheresultwithaninternal tag.

12.1 AddingInternal Tags

+ Click on Tags in the Project Explorer.
The tags configuration page opens on the desktop.

12.1.1 AreaTag

» Addatagandlabelit “Area”. Change the data type to FLOAT. The data type

for this tag and the following tag is set for the tag; not for the controller.

12.1.2  Calculation Tag

» Addatagandlabel it “Calc” and select the data type BIT.

Tag Contraollers
MName Data Type | Access Right | Data Type Controlleri
MeterandSlider  DEFALLT ReadWrite INT16 Da
Tag2 DEFALLT ReadWrite INT 16 D1
Counter DEFALLT ReadWrite INT 16 co
BoolAlarmTag DEFAULT ReadWrite DEFAULT
Weight DEFALLT ReadWrite INT16 D2
Length DEFALLT ReadWrite INT 16 D3
Width DEFALLT ReadWrite INT16 D4
Area FLOAT ReadWrite DEFALLT

I |cale B ~ ReadWrite  DEFALLT

Leaving the Controllers column empty keeps the tag internal, not connected
to a controller.

»  Switch to the Script view mode and locate the Calc tag. Click on the Calc tag
node and double-click to open the Value Change node.

To access data and methods in C# control code the keyword “Globals” is used.
The example uses explicit type casting (“(double)”), which is necessary foran
overloaded operator (multiplication).
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+ Calculate the area in the Value Change node:

Globals.Tags.hrea.Value =
{double)} Globals.Tags.Longitud.Value *
(double) Globals.Tags.hAncho.Value [/ 100;

12.2 Creatingan AnalogNumeric

1. Open Screen4 for editing. Place an Analog Numeric object below the set of
sliders for the recipe tags, clear from the rectangle object.

2. Right-click on the analog numeric and connectit to the Area tag.

Keep the object selected, select Decimal for Display Format and set Number
of Decimals to 2 on the General ribbon tab.

e
B -

Home Project System Insert View Dynamics | General

Decimal H 2 Prefix Area | Auto Stretch Font = On Input On Display
Limit Characters to 10 Suffix Select Security Groups.. ~ Disable Operator Input = Lower Limit O
Number of Decimals 2 Def. Transparent Upper Limit 0

o

| Text Alignment |

4. Usea Textobject to place an explaining text (e.g. “Area:”) in connection with
the analog numeric object.

12.2.1  CalculationTrigger

1. Open Screen4 for editing. Select the Rectangle object.

2. Go to the Actions tab and select Toggle Tag, located in the Controller group,
from the drop-down list for the MouseDown action. Select the Calc tag.
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12.3 RunningInternal Tags Test

1. Run the project.

2. Testtoset thesliders to various values. Click on the dynamic rectangle area
and observe the change of the Analog Numeric control.

0 10 20 30 40 50 60 70 80 90 100

e e

0 10 20 30 40 50 70 80 90 100

%%%%#I%%

Area:

49,14

BeijerElectronics, MAEN832F 37



Object Browser

13 ObjectBrowser

An overview of all objects included in a screen can be displayed in the Object
Browser.

Objective:

e Positioningobjectsin depth
* Lockingobjects
*  Makingobjectsinvisible

13.1 AddingaGraphical Element

Open Screen4 for editing.
2. Select the Rectangle from the Objects group of the Home ribbon tab.

3. Resize the rectangle to fitas background of the group of sliders and buttons.

The rectangle now totally obscures the other objects.

13.2 Usingthe ObjectBrowser

1. Select Object Browser from the View ribbon tab.

2. Click the Send object backward button while the rectangle is selected until
all the buttons and sliders are visible.

Object Browser > I X

4
e

| Send object backward

ok |Button3
o—Shiderl
12}#—\nalog Nurmericl
ab Textl

o—Slhider2
o—5lider3
F=iRectanglel

3. Click the Lock button while the rectangle is selected.
4. Try to move the rectangle on the screen by dragging it.

The object is locked and cannot be moved. It cannot be selected in any way.
5. Select one of the buttons and click the Visibility button.

The button is hidden. Butifthe projectis run in iX Runtime, the object will
show as normal.
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14  Multiple Texts

Text objects can be used to display textual information, and can also reflect
changes in controller tags.

Objective:

*  Presentingavariant text message that reflects the changes of the calculated area.

14.1 Configuring Texts

1. Open Screen4 for editing. Select the Text object labeled “Area:” and click on
the General tab.

2. Click on Configure Texts in the Text group. Connect the text to the Area tag.

3. Add textstrings and edit the intervals according to the example below.

With the default setting for the text object, Autosize, there is no need to adjust
the object in order to make the longest string fit in runtime.

BeijerElectronics, MAEN832F

Configure Texts ﬁ
Area - [:|
[ add || Dekte |
Text Start Value End Value
small area: 0 32
Medium area: 33 65
Large area: &6 98
3 é'u'ery large area: 99 100
[ oK || Cancel |
L A

39



‘ Multiple Texts

14.2 Running Multiple Texts Test

Run the project.

2. Testtoset thesliders to various values. Click on the dynamic rectangle and

observe the change of the analog numeric control. Check that the text is
updated as well.

0 10 20 30 40 50 60 70 B0 90 100

e e

0 10 20 30 40 50 60 70 80 90 100

F

Medium area:
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15 Security

Access to objects and actions in the project can be limited using security groups
and user passwords.

Objective:

e  Addinguser namesand setting passwords.
e Setting up loginand logout control.
*  Restricting access of recipe handling.

15.1 Security Configuration

+ Click on Security in the Project Explorer to open the configuration page.

15.1.1  Security Groups

Security is handled by dividing users into security groups. These are configured on
the Groups tab. In this example, the two default security groups, Administrators
and Operators, are used.

15.1.2 Users

Select the Users tab on the Security configuration page.

2. Addauser that belongs to both security groups; Administrators and
Operators.

3. Addanother user that belongs to Operators group only.

Username Password Description Groups

Administrator R Administrators

SuperlUser — Administrators, Operators
I (Userl Em{pv Operators

Note:
The password is converted to asterisks as you leave the password input cell.
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15.2 LoginBehavioronAccessDenied

Alogin dialog can be displayed whenever a user tries to access an object that is
restricted for the user group that the user belongs to.

1. Select the Users tab, and click the Settings button.

2. Select Show Login Dialog for action on access denied, and Normal for
visibility.

i Properties
Default settings on Access Denied
Password Rules Select action on access denied
Show Login Dialeg
Select visibility
Mormal
Automatic logout

= Logout users after

5 : minutes of inactivity

(o [ ]fsa]

[ OK | [ Cancel
15.3 CreatingalogoutButton
Open Screen3 (the background screen) for editing.
Place a button next to the “Start Screen” button. Label the button “Logout”.
3. SelectLogout, located in the Security group, from the drop-down list for the
Click action.
42
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15.4 ObjectSecurity
1. Open Screen4 for editing,.

15.4.1 Administrators

1. Right-click on the Save Recipe button and select Administrators for Select
Security Groups.

15.4.2 Users

1. Right-click on the Load Recipe button and select Operators for Select
Security Groups.

15.5 Running Security Test

Run the project.

2. Testto make sure thatitis no longer possible to load or save recipes without
logging in, and that the login dialog opens when any of the buttons are
pressed.

3. Login as Administrator and save a recipe.
4. Testtoloadarecipe.
Thelogin dialog opens.
5. Loginas Userl and load a recipe.
6. 'Testtosavearecipe.
Thelogin dialog opens.

7. Login as SuperUser. Test to save and load recipes.

/= N
Eﬁg Login
- A
User Mame
[SuperUser "l
Pazsward
qe Password
- J
Gley @y
W r
M -
8. Logout.

9. Testthatitis no longer possible to load or save recipes.
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16 FunctionKeys

Function keys can be used to perform actions and execute scripts. This allows
operator control of data and screen functionality independent of which screen
isactive.

Function keys can also be configured as local function keys, which means that they
are applicable individual screens. In this example, global function keys are used.

_{,/' Function Keys X ]

&

Functicn Key Context

9 Global ) Screen Select Screen... )

Objective:

*  Programming actions for function keys to change screen, set controller tag values,
recipe managementand display the login dialog.
*  Programming function keys to execute scripts.

16.1 Defining Function Key Actions
1. Click on Function Keys on the Insert ribbon tab.

16.1.1 Show Screen

1. Clickon... under Action on the row for function key F1 to open the
Properties dialog. Click Add and select Show Start Screen, located in the
Screen group, from the New Action dialog.

iX) Properties EI@
Actions g‘

@Tr‘igger: Key down -

¥ | Add action lreen - ()4
[ OK | [ Cancel

2. Click on the row for function key F2. Select Show Screen as action, and
Screen2 from the screen drop-down list.
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3. Setup function key F3 to show Screen4.

16.1.2  Security

+  Click on the row for function key F4. Select Login, located in the Security
group, as action.

16.1.3  Setting Controller Tag Values

1. Click on the row for function key F5. Select Set Analog as action, located in
the Controller group, and the Weight tag from the Select Tag drop-down list.
Specify the analog value 50.

2. Setup function keys F6 and F7 to control the Length and Width tags.

16.1.4  Recipe

+  Setup function key F8 to load Recipel, and function key F9 to save Recipel.
Leave Recipe data empty.

16.1.5  Setting Time Zone, Region and
Daylight Saving

»  Setup function keys F10 to set time zone, region and daylightsaving. The
action is located in the Other group.

Function Key Actions
F1 Show Start Screen
F2 Show Screen
F3 Show Screen
F4 Login
F5 Set Analog
F& Set Analog
F7 Set Analog
F8 Load Recipe
F9 Save Redpe
» |[F10 ESet Time Zone, Region and Daylight Saving
Show Start Screen
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16.2 Defining FunctionKey Scripts
Function keys can also be used to trigger scripts.

16.2.1 Area Calculation

Program a function key with the area calculation for the rectangle object:

1. Click on the row for function key F11. Select Script view mode by clicking on
the Script tab at the bottom of the screen.

2. Clickon the F11 node, and double-click on its KeyDown node.

Calculate the area on the KeyDown event with this code:

Globals.Tags.Area.Value =
(double) Globals.Tags.Longitud.Value *
(double) Globals.Tags.hAncho.Value [/ 100;

Using a function key script eliminates the need for the separate trigger tag

(Calc).
16.2.2  Acknowledge All Alarms

Program a function key with an “Acknowledge All” for alarms:
1. Select the KeyDown node for function key F12.
2. Type the following KeyDown event code:

Global=s.AlarmServer. hcknowledge () ;

C# code in the script tab:

public partial class FunctionKeys
{

wvoid F11 EeyDown (System.Object sender, System.Eventirgs e)
{
Global=s.Tags.Area.Value =
(double) Globals.Tags.Longitud.Value *
(double)} Globkals.Tags.hncho.Value /100;

void F12 KeyDown (System.Object sender, System.Eventirgs e)

{
Glokbals.AlarmServer.Acknowledge () ;
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16.3 Running Function Key Test

1. Run the project.
2. Testthat the defined functions keys (on the PC keyboard) perform the defined

actions.
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17 CrossReference

The Cross Reference tool provides an overview of where a specific tag is used in
the current project.

Objective:

e Locatingall occurrences of aspecific tag quickly.

17.1 Usingthe CrossReference Tool

1. Select the MeterAndSlider tag in the Tags configuration page, and click the
Cross Reference button.

The Cross Reference tool is displayed.

Cross Reference 1 X
Tags.MeterAndSlider

Screenl.CircularMeterl (Value)
Screenl.Sliderl (Value)
Screenl.Trendl.Curve 1 (Valug)
TrendDataleggerl.Loglternl (Value)

2. Double-click on the first item in the list.

The Alarm Server configuration page opens on the desktop.
3. Double-click on the third item in the list.

Screenl opens on the desktop, and Slider1 is selected.
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